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The following areas have been updated in PowerSHAPE 2011:  

 Using PowerSHAPE 2011 (see page 1). 

 Import and Export enhancements. (see page 2) 

 User interface (see page 2). 

 Surface modelling (see page 14). 

 Solid modelling (see page 17). 

 Triangle modelling (see page 22). 

 Delcam Draft (see page 53). 
 

Using PowerSHAPE 2011 
The following changes have been made to the general operation of 

PowerSHAPE 

 All models opened in PowerSHAPE 2011 use model version 22.  

When PowerSHAPE 2011 is installed and run for the first time, the 

initialisation work will open the latest 

NEW_MODEL_MASTER_XX you have (where XX <22) and 

save it as NEW_MODEL_MASTER_22. 

 PowerSHAPE now allocates memory for the database dynamically, 

based on the contents of the model. Previously, a fixed amount of 

memory was reserved when starting PowerSHAPE. Allocating 

memory dynamically reduces the amount of memory required, 

especially for Parasolid-based models. 
 

What's New in 
PowerSHAPE 2011 
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Import and Export enhancements 
PowerSHAPE 2011 includes the following import/export enhancements: 

 Parasolid binary formatted files (.x_b) can now be imported and 

exported. Previously only Parasolid text files (.x_t) could be used. 

 Colours are a useful way to define machining intent, or pass other 

useful information between systems. The use of colours when 

importing and exporting Parasolid files has been updated: 

 The wireframe colour of each face is exported to .dgk and 

Parasolid formats. 

 Colours defined in other systems are retained when Parasolid 

files are imported into PowerSHAPE. 

 Component names are now preserved when exporting the 

components as solids, for example when exporting an assembly 

component as .dgk file. 

 Use Flatten assembly hierarchy to flatten the assembly 

hierarchy (see page 7) when exporting or importing Parasolid.  
 

User interface 
Changes have been made to the interface in PowerSHAPE 2011: 

 The PowerSHAPE title bar indicates whether you have installed a 

32-bit or 64-bit version. 

 

 

 Menus (see page 2) 

 Toolbars (see page 3) 

 Dialogs (see page 7) 
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Menus 

The following changes have been made to the menus: 

 Options have been added to the Object > Mesh sub-menu to 

reflect the changes to the Mesh toolbar: 

Select triangles (see page 23) 

Select triangle area (see page 24) 

Smooth mesh (see page 42) 

Paint triangles (see page 42) 

Morph mesh (see page 28) 
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Toolbars 

Changes to the toolbars in PowerSHAPE 2011 are described in the 

following sections. 

 Mesh Edit toolbar (see page 4). 

 Schedule toolbar (Delcam Draft) (see page 4). 

 General Edits toolbar (see page 5). 

 As part of the continuing integration of the embedded CopyCAD 

functionality into PowerSHAPE, a number of buttons have been 

removed from the embedded CopyCAD toolbar. Full details can 

be found in Triangle Modelling. (see page 22)  

 The Solid Edit toolbar is now displayed when one or more solids 

are selected. 
 

Mesh Edit toolbar 

The following changes have been made to the Mesh Edit toolbar: 

 There are a large number new buttons on the Mesh Edit toolbar.  

 

 As well as changes to the functionality, there are some changes to 

licensing.  

Full details of new functionality and licence changes can be found in 

Triangle Modelling (see page 22). 
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Schedule toolbar (Delcam Draft) 

The Schedule toolbar has been updated.  

 

The previous Schedule option has been replaced by two new options: 

 Hole schedule (see page 55) 

 Ejector schedule (see page 55). Use this to produce a 

schedule for ejector pins, core pins and return pins. 
 

General Edits toolbar 

The following changes have been made to the General Edits toolbar: 

 Use Align items  to adjust the alignment of the model using 

the Align items dialog. 

 Limit to polygon has been added to the Limit selection 

toolbar. 

 

1. Select a mesh. 

2. Select Limit selection  (Limit flyout, General Editing 

toolbar) to display the Limit selection toolbar. 

3. Click  (Limit selection toolbar). 
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4. Click the start point and click additional points to create a 

polygon on the mesh. Click the start point again. 

 

The polygon is used as the cutting tool. 

 Show deviations  has been added to the Sculpting toolbar. 

Use this option to see the difference between the original and 

sculpted models when using the editing tools. 

 

1. Select a mesh. 

2. Select  (General Edits toolbar) to display the Sculpting 
toolbar. 

3. Click  (Sculpting toolbar) and move the mouse to add 

material to the mesh. 
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4. Click  (Sculpting toolbar) to see the difference between the 

original and the sculpted model. The analysis scale lets you see 

the percentage material that you have added to the model.  

 

Alternatively, click  before adding the material to see the 

dynamic changes. 
 

Dialogs 

Changes have been made to dialogs in the following areas of 

PowerSHAPE 2011: 

 Solid modelling (see page 9) 

 Delcam Draft (see page 11) 

 Triangle modelling (see page 11) 

 General editing (see page 12) 

 PowerSHAPE models are saved as a Single File by default. The 

Directory option is no longer available on the Tools > Options 
> File > Model dialog. 
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 Create a copy of the workplane by clicking  when using one of 

the following edit dialogs: 

primitive surfaces. 

primitive solids. 

primitive solid features. 

 

 Primitive extrusion dialogs have been modified to let you define a 

second draft angle on the Dimension tab.  

 

 Changes have been made to the Cone dialog box, so that you can 

specify which dimensions are used to define the primitive cone. 

 

1. Select one of the following options from the drop-down list:  

Base radius and top radius  
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Top radius and angle  

Base radius and angle  

2. Enter the dimensions for the cone. The option that you selected 

from the drop-down list determines which options that are 

available on the dialog. It also affects the dimensions that can be 

changed using graphical editing.  
 

Solid modelling 

The following changes have been made to solid modelling dialogs: 

 Creating and editing a Solid Chamfer and Solid Fillet has been 

streamlined. The same dialog is now used to create and edit a 

feature, making chamfers and fillets consistent with other features.  

 Solid Fillet and Edit Solid Fillet dialogs now include Always 
Extend Faces. 

 

 If selected, this option will always extend any face that will overlap 

the fillet, in order to maintain a fixed radius. For further details see 

Solid features (see page 19). 
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 Solid Hints displays the Operation Fault Report when an 

operation fails when working with Parasolid solids.  

 

Use the information in the two sections of the dialog to help 

identify the areas of the model where problems were encountered 

(see page 21). 

 Flatten assembly hierarchy has been added to the Parasolid 

Options dialog. 

1. Select Tools > Options > Data Exchange > Parasolid to 

display the Options dialog. 

 

2. Select Flatten assembly hierarchy to flatten the assembly 

hierarchy when exporting or importing Parasolid.  
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This option should be used when exporting Parasolid files to a 

system that does not support assemblies. It can also be used if you 

wish to work with the geometry as individual solids without the 

assembly structure. 
 

Delcam Draft 

The following changes have been made to the dialogs in Delcam Draft: 

 There is a new Options dialog for Bill of Materials: 

1. Select Tools > Options > Drafting > Bill of Materials to 

display the Options dialog (see page 54). 

2. Enter Rough Oversize Value. This value is the additional 

allowance that is added to the bounding box to calculate the 

stock size required to make the item. 

 The Bill of Materials and Schedule dialogs have been updated 

as follows: 

 The Drawing and Save buttons have been replaced by the  

Save to file. This button toggles between drawing the 

BOM/schedule on the diagram and saving to a file using the 

Save As dialog. 

 Dismiss has been replaced by OK and Cancel. These operate 

in the normal way. 
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Triangle modelling 

The following change has been made to the dialogs in triangle modelling: 

 Reduce Mesh dialog has been updated to include a Percentage 
option.  

 

Enter a value to specify the percentage of the original number of 

triangles you want in the new mesh. For further details see Other 

changes to triangle modelling (see page 51). 
 

General editing 

Use the Align items dialog to adjust the alignment of the model. 

1. Click  (General edits toolbar) to display the Align items 
dialog. 

 

2. Select the alignment object . This is the object that will move. 
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3. Click Select reference object and select the object  . This is 

the object that will not move. 

 

If necessary, click  to move the alignment object alongside the 

reference object. This is not necessary in this example. 

4. Click Define points and select points on the alignment and 

reference object. You must define at least three sets of points; the 

information panel tells you that you have sufficient points selected. 

Choose points in one of the following ways: 

 all points on alignment object followed by all points on the 

reference object. 

 pairs of points, one on the alignment object and one on the 

reference object. 

 

5. Adjust the point selection as appropriate, using the following 

buttons: 

 to undo the last selected point on the alignment object. 

 to undo the last selected point on the reference object. 
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6. Click Apply. The alignment object will move so that the selected 

points are aligned.  

 

Continue to select objects and points to adjust the alignment as 

necessary. 

7. Click OK to accept the changes and close the dialog box. 

 
 

Surface modelling 
Changes have been made to the following areas of surface modelling: 

 Primitive cone (see page 15). 

 Primitive extrusion (see page 15). 

 Surface from a mesh (see page 16). 

 When editing a primitive surface, create a copy of the workplane 

by clicking  on the dialog. 

 

The new workplane does not become the active workplane. 
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Primitive cone (surface) 

A primitive cone is now specified as follows: 

1. Enter the Length of the cone. 

2. Select one of the options from the drop-down list.  

 

Your selection determines the other options that are available on 

the dialog. It also affects the dimensions of the cone that can be 

changed using graphical editing.  

3. Enter the other parameters. 

4. Click OK. 
 

Primitive extrusion 

Use the Extrusion dialog to define a draft angle for the negative length 

of a primitive extrusion.  

1. Create an extrusion from wireframe. 

 

2. Double click the extrusion to display the Extrusion dialog. 
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3. Enter the Length and Draft Angle for Direction 1. The model 

will be updated to reflect the values you entered. The model below 

has a Length of 47 and a Draft Angle of 0. 

 

4. Enter the following values for Direction 2: 

20 (Length) 

15 (Draft Angle) 

The model is updated to reflect the Direction 2 values. 

5. Click OK. 
 

Create surface from a mesh 

The following functionality has been added to provide more flexibility 

when creating a surface from a mesh: 

 Use the following operations when creating a surface from a mesh 

 

Insert discontinuity to a surface edge. 

 

Finish a surface edge. 
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Add an intermediate point to a surface edge. 

This option is also used to finish a surface 

contour, when the  is used to indicate the 

start point of the contour. 

 Use  to undo points when creating the curve. Once the surface 

has been created,  cancels the whole surface creation. 
 

Solid modelling 
Changes have been made to the following areas of solid modelling: 

 Select one or more solids to display the Solid Edit toolbar. Use 

the buttons on the toolbar to convert the solids to surfaces or 

meshes, as required. 

 

 The Undo button on the Solid Doctor dialog now allows each 

repair operation to be undone. Previous releases only allowed the 

last operation to be undone. 

 Solid primitives (see page 17) 

 Solid features (see page 19) 

 Solid Hints (see page 21) 
 

Solid primitives 

 Use the Extrusion dialog to define a draft angle for the negative 

length of a primitive extrusion.  

1. Create an extrusion from wireframe. 

 

2. Double click the extrusion to display the Extrusion dialog. 
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3. Enter the Length and Draft Angle for Direction 1. The 

model will be updated to reflect the values you entered. 

 

4. Enter the Length and Draft Angle for Direction 2. The 

model is updated to reflect Direction 2 values: 

20 (Length) 

15 (Draft Angle) 

5. Click OK. 

 When editing a primitive solid or primitive solid feature, create a 

copy of the workplane by clicking  on the dialog. 

 

The new workplane does not become the active workplane. 



 

PowerSHAPE 2011 What's New What's New in PowerSHAPE 2011 • 19
  

 

 A primitive Cone is now specified as follows: 

1. Enter the Length. 

2. Select one of the options from the drop-down list.  

 

3. Your selection determines the other options that are available on 

the dialog. It also affects the dimensions of the cone that can be 

changed using graphical editing.  

4. Enter the other parameters. 

5. Click OK. 
 

Solid features 

The following changes have been made to modelling with solid features: 

 The default creation mode has been removed from solid feature 

creation. 

1. Click  (Main toolbar). 

2. Select the required feature from the feature toolbar. 

 Edit Solid Chamfer and Edit Solid Fillet dialogs have been 

revamped. The updated dialogs have a similar layout to the 

corresponding creation dialog.  

 Solid Fillet and Edit Solid Fillet dialogs now include Always 
Extend Faces. If this option is selected, any face that will 

overlap the fillet is extended to maintain a fixed radius. 
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1. With the solid displayed, click  to display the Fillet dialog 

2. Select edge of the fillet. 

3. Click Apply. The fillet partially overlaps additional non-

tangential geometry, giving an imperfect fillet. 

 

4. Click  to undo the fillet. 

5. Select Always Extend Faces. 

6. Select the edge of the fillet. 
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7. Click Apply. The fillet radius is maintained. 

 

8. Click OK to accept the changes. 
 

Solid Hints 

Solid Hints may help you identify the areas of a model that are causing 

problems. 

If an operation fails when using a Parasolid solid, the Operation Fault 

Report dialog may be displayed.  

 

The dialog indicates any problem areas when performing the operation. 

Use the options on the dialog to identify the area that requires attention.  
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Modelling with triangles 
There are a large number of changes to triangle modelling in 

PowerSHAPE 2011. As well as changes to the functionality, there are 

some changes to licensing. 

Full details of the changes to triangle modelling are described in the 

following sections: 

 Mesh Edit toolbar (see page 22). 

 Mesh Fixing and Editing toolbar (CopyCAD) (see page 48). 

 Other changes to triangle modelling (see page 51). 

A table showing the complete list of functionality that is available with 

different licences is included (see page 49). To improve clarity in the 

documentation, licensed options are indicated using the following icons: 

 Requires a PowerSHAPE Pro, Delcam Designer or CopyCAD 

Pro licence. 

 Requires a PowerSHAPE Pro or CopyCAD Pro licence. 

 Requires a CopyCAD Pro licence. 
 

Mesh Edit toolbar 

 The following buttons have been added to the Mesh Editing 

toolbar.  

Lasso (see page 23) 

Select Triangles (see page 24) 

Smooth mesh (see page 42)  

Paint Triangles (see page 42)  

Morphing triangles (see page 28)   

Add triangle (see page 46)  

Each button also has a corresponding option on the Object > 
Mesh sub-menus. 

 Licensing of Draft wall has changed. It now requires a 

PowerSHAPE Pro, Delcam Designer or CopyCAD Pro licence.  
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 The following buttons have been restyled 

Reduce Triangles   

 Refine Triangles   

 Delete Triangles 
 

Lasso 

Use the new  Lasso flyout on the Mesh Edit toolbar to pick triangles. 

 

 Use  to pick triangles on a mesh using a continuous lasso. 

Lasso functionality was added to the Mesh Edit toolbar in 

PowerSHAPE 2010 R2. 

 Use  to pick triangles on a mesh using discrete lasso: 

1. With an active mesh, select  from the lasso flyout. 

2. Click the mesh to define the points on the boundary of the 

picking area. 

 

3. Click the first point again to create the picking area. All the 

triangles that lie within picking area are selected. 
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  or  away from the model to deselect the selected 

triangles, but leave the mesh selected. 

Use CTRL D to deselect the selected triangles and the model. 
 

Select triangles 

Use the new Select triangles flyout to select triangles on a mesh. 

1. With a mesh active, click  to display the buttons on the Select 

triangles flyout. 

 

2. Select one of the following options from the Select triangles 

flyout: 

 Select all triangles in the mesh 

 Select triangles with the same colour 

 Select triangle area to discontinuity angle 

 Select triangle area to local horizon angle 

 Select triangle area to distance 
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Selecting all triangles in a mesh 

1. Select a mesh and click  to display the Select Triangles 

flyout. 

2. Click  to select all the triangles in the mesh. 

 

Selecting triangles with the same colour 

1. Select a mesh that contains some coloured triangles. 

2. Click  to display the Select Triangles flyout. 

3. Click  

4. Click in the coloured area that you wish to select. All the triangles 

in that are selected. 
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Select triangle area to discontinuity angle 

1. Select a mesh and click  to display the Select Triangles 

flyout. 

2. Click  to display the Set angle dialog. 

 

3. Click the model. Triangles are selected that lie within the 

discontinuity angle defined by the slider. Use the slider to increase 

or decrease the triangles that are selected. The example shows a 

cone with a 15  angle. 

 

Select triangle area to local horizon angle 

1. Select a mesh and click  to display the Select Triangles 

flyout. 

2. Click to display the Set angle dialog. 
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3. Click the model. Triangles are selected that lie within the angle 

defined by the slider in the Set angle dialog. Use the slider to 

increase or decrease the triangles that are selected. 
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Select triangle area to distance 

1. Select a mesh and click  to display the Select Triangles 

flyout. 

2.  to display the Set Distance dialog. 

 

3. Click the model. Triangles are selected that lie within the distance 

defined by the slider in the Set distance dialog. Use the slider to 

increase or decrease the triangles that are selected. 
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Morph mesh 

A Morph flyout has been added to the Mesh Edit toolbar.  

 

Use the buttons on the flyout to  

 Use morph techniques to change the shape of the mesh (see page 

29). 

 Morph triangle regions that are defined by planes (see page 29). 

 Morph triangle regions that are defined by polygons (see page 35). 
 

General morphing 

1. Select  from the morphing flyout to display the Morphing 
dialog. This is the same as the dialog used with solid morphing. 

 

2. Use the tabs on the dialog to deform the active mesh into a 

different shape. 
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Morphing triangle regions defined by planes 

You can transform one or more regions of the model. The regions are 

defined by planes. 

1. Select  from the morphing flyout to display the Morph 
Triangles by Planar Regions dialog.  

 

Two planes are used to define the regions of the model.  

 

2. Adjust the position of a planes by double-clicking the plane and 

modifying the coordinates using the Plane dialog. 

3. Select an option from the Transform region drop-down list: 

 None - This is the default setting. There will be no blending 

between the central region and the outer regions. 

 Move - Use this option to move the region between the two 

planes. Enter X, Y and Z values to indicate the amount to move 

along the axes. 
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 Rotate - Use this option to rotate the region between the two 

planes. Enter a rotation value. Use  to define a new rotation 

origin. 

 Scale - Increase or decrease the size of the region by entering a 

scale Factor. For example if you want to increase the size of 

the region by 20% enter a Factor of 1.2. By default, Factor 

will be applied in all directions. Use  locks to suppress 

scaling in a specific axis. 

Use  to define a new position for the scale origin. 

 Offset - Define the offset for the region by entering a 

Distance. 

4. Specify the Blend to be used Before and After the transform 

region. Additional planes are added to the model that define the 

blend region. 

The following blend types are available: 

 None. If you select this option, there will be no blend between 

the transformed region and the adjoining regions. 

 Smooth. Select this option, to create a smooth curve between 

adjoining transform regions. The curve is tangential at both 

edges of the blend region. 

 Linear - Select this option to create a straight-line blend 

between the two transform regions. 

 Smooth to Sharp - The transition uses a tangential curve next 

to the first transform region, and a linear blend next to the 

second transform region. 

 Sharp to smooth - The transition uses a linear blend next to 

the first transform region, and a tangential curve next to the 

second transform region. 

5. Use the buttons on the Region navigator to specify the region to 

be morphed. 

6. Click Preview to view the morph.  

7. Click Apply to morph the region and continue to display the 

dialog. This lets you make further modifications to the same region 

or modify a different region. 
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Example of morphing triangles using planar regions. 

1. Select the mesh. 

2. Click  to display the Morph Triangles by Planar Regions 

dialog. Planes are used to indicate the different regions on the 

model. 

 

3. Double click the top plane to display the Plane dialog.  

4. Define the top plane as follows: 

a. Set Z to 30. 

b. Click OK to move the plane. 

5. Double click the bottom plane to display the Plane dialog. 

6. Define the bottom plane as follows: 

a. Set Z to 15. 
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b. Click OK to move the plane. The top and bottom planes now 

look like this:  

 

7. Define the Transform region as follows: 

a. Select Rotate from the drop-down list. 

b. Set the Angle to 10. 

c. Click Preview. The region between the two planes is rotated 

by 10 degrees. 

 

8. Specify the Blend as follows: 

a. Select Smooth from the Before drop-down list. 

b. Select Linear from the After drop-down list. 

c. Click Preview.  

The bottom blend between and  is created using the smooth 

algorithm 
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The top blend, between  and , is created using the linear 

algorithm. 

 

9. Press  to move to the bottom region . 

10. Create an offset region as follows: 

a. Select Offset from the Transform Region drop-down list. 

b. Set Distance to 1. 

c. Click Preview. Region  is offset by 1. 

 

11. Press  twice to move to the top region . 

12. Create an offset region as follows: 

a. Select Offset from the Transform Region drop-down list. 

b. Set Distance to 2. 
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c. Click Preview. Region  is offset by 2. 

 

Steps 1 to 12 have modified the original model as follows: 

 Region  is rotated by 10 . 

 Bottom blend  uses the smooth algorithm. 

 Top blend  uses the linear algorithm. 

 Bottom region  is offset by 1. 

 Top region  is offset by 2. 
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Morphing triangle regions defined by polygons 

Morph regions on a model, using polygons to define the areas. Using 

polygons lets you reshape up to three regions: 

 within an inner polygon,  

 outside an outer polygon 

 between the two polygons  

Use the following example to identify these regions and the polygons: 

 

 Inner transform region. 

 Inner polygon. 

 Blend region. 

 Outer polygon. 

 Outer transform region. 

Using this method.it is possible to move a single point and blend the 

move into the rest of the model. This technique is useful counteract 

the sagging of the centre of a part after manufacture.  
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The example uses the centre of gravity to compensate for sag that will 

occur at the centre of a plate after it has been made. In this case the 

centre of the plate is moved by 2.0 and a smooth blend applied to the 

outer polygon around the edge of the plate. 

Creating the inner and outer polygons 

Use one of the following methods to create the inner and outer polygons: 

 Sketch a polygon on the model, using as many points as required 

and clicking on the first point to  close the polygon. 

 Select an open model; the boundary will be used as the polygon. 

You can use triangle or closed polyline models. Use this option for 

the outer polygon, to create a polygon around the boundary of the 

model. If  you use this method, you can define an inner polygon 

and blend from this to the edge of the model. 

 Select a single point for the inner polygon. This has the effect of 

creating a blend region from the model's centre of gravity to the 

outer polygon. 

To morph the regions defined by polygons 

1. Select a mesh that includes sketched inner and outer polygons. 

2. Select  from the morphing flyout to display the Morph 
Triangles by Planar Regions dialog.  

 

3. Select an option from the Inner transform region drop-down 

list: 

 None - This is the default setting. There will be no morphing of 

the inner region. 
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 Move - Use this option to move the inner region. Enter X, Y 

and Z values to indicate the amount to move along the axes. 

 Rotate - Use this option to rotate  the inner region. Enter a 

rotation value. Use  to define a new rotation origin. 

 Scale - Increase or decrease the size of the region by entering a 

scale Factor. For example if you want to increase the size of 

the region by 20% enter a Factor or 1.2. By default, Factor will 

be applied in all directions. Use  locks to suppress 

scaling in a specific axis. 

Use  to define a new position for the scale origin. 

 Offset - Define the offset for the region by entering a 

Distance. 

4. Select the type of blend to be used. The following blend types are 

available in the drop-down list: 

 Linear - Select this option to create a straight-line blend 

between the two transform regions. 

 None -  If you select this option, you cannot define an Outer 
transform region or select an outer polygon. There will be no 

blend between the transformed region and the adjoining regions;  

 Smooth - Select this option to create a smooth curve between 

adjoining transform regions. The curve is tangential at both 

edges of the blend region. 

5. Select an option from the Outer transform region drop-down 

list. If you selected a blend type, you must specify how you want to 

morph the region outside the outer polygon.  

6. Choose one of the following options to Define inner polygon: 

 Curve and select the inner polygon. 

 Point and click  to select the Centre of Gravity. 

7. Choose one of the following options to Define outer polygon: 

 Curve and select the outer polygon. 

 Offset and enter the offset value. 

8. Click Preview to view the morph.  

9. Click Apply to morph the region and continue to display the 

dialog. This lets you make further modifications to the same region 

or modify a different region. 
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Example of morphing triangle regions defined by polygons - Two 
contours 

1. Select the mesh. 

 

2. Click  to display the Morph triangle regions defined by 
polygons dialog. 

3. Select Move from the Inner transform region drop-down list. 

4. Enter a Z value of 5. 

5. Select Smooth as the Blend type. 

6. Click inner contour . 

7. Click outer contour . 

 

8. Click Preview. 
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This shows the following changes: 

 The inner region has moved upwards by 5. 

 Blend area (between the two contours) is created using the 

smoothing algorithm. 

9. Select Scale from the Outer transform region. 

10. Enter 1.5 as the scale Factor. 

11. Click  to lock the X axis. 

12. Click Preview. 

 

This shows that: 

 The outer region is scaled by 1.5.  

 The region has not been scaled in the X direction. 
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Example of morphing triangle regions - contour and point 

1. Select the mesh. 

 

2. Click   to display the Morph triangle regions defined by 
polygons dialog. 

3. Select Linear from the Blend drop-down list. 

4. Select Move from the Outer transform region drop-down list. 

5. Enter a Z value of 10. 

6. Click Point to define the inner polygon. 

7. Click  to highlight the centre of gravity. 

The point is highlighted in blue  

8. Click the outer contour . 

 

9. Click Preview to display the model.  

 

10. This shows that: 

 The inner region (the point) has not moved. 
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 The outer region has been raised by 10. 

 The blend area has been created using the linear algorithm. 
 

Smooth mesh 

Smooth mesh has been added to toolbar.   

1. With a mesh selected, click  to display the Smooth mesh 

dialog.  

 

Use this dialog to filter out noise in a mesh. 

2. Enter a Tolerance. This distance is used to determine the nodes 

that are affected by the smoothing process. 

In the example below, Smoothing Tolerance has been set to 20 

so that the results of smoothing are clearly visible. Normally a 

much lower figure would be used. 

 

3. Click Apply to smooth the mesh and continue with smoothing. 

4. When smoothing is complete, click OK to close the dialog. 
 

Paint triangles 

Paint Triangles has been added to the toolbar. The functionality is also 

available from the Format menu.  

1. Click Paint triangles  to display the Paint triangles dialog. 
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2. Select the colour to paint the triangles, using one of the following 

methods: 

 Click the drop-down list  to display the colour palette.  

 

If the colour you want is not displayed in the palette, click 

Other button to display the Colour dialog. Create a custom 

colour by specifying the values for RGB, Hue, Saturation 

and Luminosity. 

 To use a colour that is already used in the mesh, click  and 

then pick colour on the mesh. The picked colour is displayed in 

the colour drop-down list. 

3. Pick the triangles to paint using: 

 box picking. 

 lasso (continuous or discrete (see page 23)). 

 one of the Select triangles options (see page 24). 

4. Use  to remove the colour from the selected triangles in the 

mesh. 
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Fill holes 

Use Fill Holes  to fill holes in the model by selecting the open 

boundaries.  

If the hole to be filled covers an area of different curvature, split the hole 

into smaller regions, and fill them separately. This allows more 

complicated holes to be fixed without the need for full manual triangle 

editing. After selecting a hole to fill, you can pick two points on the 

boundary to split the hole into two regions. If the wrong side is 

highlighted by default, click to select the region that you want to fill. 

For example, using the plate.stl example file supplied with PowerSHAPE, 

fill the hole in two parts, filling the flat area with a planar cap, and the 

curved area with a curvature cap. 

 

1. Select a mesh to display the Mesh Edit toolbar. 

2. Click Fill Holes  to display the Fill Holes dialog. 
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3. Select the hole by clicking its boundary . The selected boundary 

turns blue. 

 

4. Select two points to specify part of hole you want to fill first. A 

mark is added at the position of the first point. A line connects the 

first point to the second point. The area to be filled is outlined as a 

blue hole . The alternative selection is outlined by a dashed blue 

line . Swap the selection by clicking the outline of the region 

required. 

 

5. Select one of the following Mode options: 

 Curvature cap calculates the curvature needed to fill the hole 

by examining the surrounding triangles. New nodes are 

generated on the curved area. New triangles are generated using 

the boundary nodes and the new nodes.  
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 Planar cap generates a nominal plane that passes through the 

boundary nodes (approximately if the boundary is not planar). 

New nodes that are within the boundary are generated on the 

plane. New triangles are generated using the boundary nodes 

and the new nodes. 

The examples below show how important it is to select the correct 

Mode option. The example shows that in this case, as the hole is 

on a curved area, you should use the Curvature cap option. 

 Hole filled with a Curvature cap 

 

 Hole filled with a Planar cap 

The average length between nodes surrounding the hole is 

displayed in the Distance between cap nodes. This value is 

used to determine the density of the new nodes. Change the value 

as required. 

6. Click Apply to apply the changes you have made and leave the 

dialog displayed to continue filling holes. 

7. Click OK when you have finished filling the hole. 
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Add triangle 

Use Add Triangles  to add triangles to the model by clicking on 

existing triangle vertices.  

1. Select a mesh. 

A section of the mesh shown below has some missing triangles: 

 

2. Click Add Triangles . 

3. Select the first point (or vertex) with the left mouse button . This 

point is marked in blue. 

 

4. Select the second point . 

5. Select the last point .  
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The new triangle is drawn. Open edges that don't match the 

existing triangles are drawn in yellow. 

 

6. Add further triangles as required. 

7. When you have finished adding triangles click Add Triangle  

to cancel the operation. 
 

Mesh Fixing and Editing toolbar (CopyCAD) 

As part of the continuing the integration of CopyCAD functionality into 

PowerSHAPE, the following buttons have been removed from the 

embedded CopyCAD toolbar. They have been added to the PowerSHAPE 

Mesh Edit toolbar (see page 22), unless otherwise stated in the following 

table: 

Embedded CopyCAD PowerSHAPE 2011 

 
Remove undercuts 

  
Create draft wall  

 
Delete triangles 

 
Delete triangles  

  
Reverse triangles 

  
Reverse mesh  

  
Refine triangles 

 
Refine mesh  

 
Tolerance triangles 

  
Reduce mesh  

  
Align triangles 

 

 

Move/Copy (General Edits) 

 

Align items (General Edits) 

  
Measure  Calculator (Status bar) 

  
Filter triangles 

  
Smooth triangles  
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Licensing of triangle modelling functionality 

Use the following table and legend to see the triangle modelling 

functionality that is available with each licence in PowerSHAPE2011. 
 

Not available 
 

Available 
 

Available in embedded CopyCAD 

 

Tool PS Designer PS Pro CCAD Pro 

Mesh Fixing & Editing 

toolbar 

   
 

Mesh Edit toolbar 
   

 
 

Add triangles  
   

 
 

Draft mesh 
   

 
 

Reduce 
   

 
 

Refine 
   

 
 

Smooth 
   

 
 

Divide 
   

 
 

Combine 
   

 
 

Reverse 
   

 
 

Hole filling 
   

 
 

Doctor 
   

 
 

Stitch 
   

 
 

Remove 

overlaps 

   
 

 
Z-

compensation 

   
 

 
Mask 

   
 

 
Delete 

   
 

 
Paint 

   
 

 
Morph 
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Pick 

   
 

Mesh/point cloud 

alignment (General 

Edits) 

   
 

Surface/solid alignment 
   

 

Splitting using painted 

regions 

   
 

Curves from 

intersections with 

meshes 

   
 

Oblique mesh (Curve 

toolbar) 

   
 

Draft/horizon mesh 

(Curve toolbar) 

   
 

Booleans with meshes 
   

 

Fit surface to mesh 
   

 

Fit curves to mesh 
   

 

Sculpt 
   

 

Triangle/edge shading 

options 

   
 

Mesh limiting 
   

 

Curve from 

discontinuities 

   
 

Curve from boundaries 
   

 

Convert surfaces/solid 

to mesh 

   
 

Import mesh as solid 
   

 

Convert mesh to solid 
   

 

Import Point Cloud 
   

 

Import CCAD session 
   

 

Mesh offset 
   

 

Error analysis 
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Other changes to triangle modelling 

 In addition to the Select Triangles options (see page 24) on the 

Mesh Edit toolbar, triangles on a mesh can be selected using the 

box selection method. The anchor point for the drag box must not 

lie on the mesh. 

Reduce Mesh 

Use the Reduce Mesh option to specify the percentage of the original 

number of triangles you want in the mesh. 

1. Select a mesh. 

2. Click  (Mesh edit toolbar) to display the Reduce mesh 

dialog. 

3. Select Percentage. 

4. Enter the percentage of the original number of triangles to be in the 

mesh. In the example below, 75 was entered as the Percentage. 

The number of triangles in the mesh has been reduced by 25%, 

resulting in a less smooth mesh. 

 



 

52 • What's New in PowerSHAPE 2011 PowerSHAPE 2011 What's New  

Surface from triangles 

When creating a surface from the triangles in a mesh, the triangles used to 

create the surface will become masked. 

1. Select a mesh. 

 

2. Click  (Surface toolbar). 

3. Create a surface from a mesh by picking points on the mesh to 

create a closed curve. When completing the curve,  is displayed 

when you move the cursor near the start point 

The model below shows two surfaces created from the mesh. 

 

4. With the surface selected, click  (Views toolbar) to blank the 

surface. The underlying triangles are displayed as masked. 
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Mesh popup menu 

The following options have been added to the Mesh popup menu: 

Select all 

Invert selection 

Restore previous selection 

Clear selection 
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Delcam Draft 
The following changes have been made to Delcam Draft: 

 If a tapped hole is dimensioned around the perimeter of the hole, 

the thread details are displayed. The information that is displayed 

depends on the standard of the tapped hole.  

 The ISO metric standard uses thread designation/ nominal 

diameter/ pitch/ optional tolreance. The following example 

shows, a 16mm IMF hole. This is dimensioned as M16 x 1.5, 

showing the diameter of the hole and the pitch of the thread. 

 

 The American standard uses nominal diameter/ threads per 

inch/ thread designation. For example, 3/4 -24 UNF. 

 The British standard uses nominal diameter / thread 

designation. For example, 1/4 BSP. 

 Bill of Materials (see page 54). 

 Schedule (see page 55). 
 

Bill of Materials 

 If the part number and catalog of components are the same, but the 

descriptions are different, the description will be omitted in the Bill 

of Materials. 

 Components based on round primitives (cone, cylinder, torus, or 

spring) are now specified using Length x Diameter. Previously, 

Length x Width x Height was used. 

 A best-fit bounding box is now used to specify sizes for 

components that are not based on primitives. This gives accurate 

sizes for components that are positioned at compound angles (for 

example, sliders) 
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 Use Tools > Options > Drafting > Bill of Materials to specify 

the Rough Oversize Value.  

1. Select Tools > Options > Drafting > Bill of Materials to 

display the Options dialog. 

 

2. Enter Rough Oversize Value. This value is the additional 

allowance that is added to the bounding box to calculate the 

stock size required to make the item. 
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Schedule 

The Schedule toolbar has been updated. It now includes two schedule 

options: 

 

Hole schedule 

1. Create a drawing of the model. 

 

2. Click  to produce a schedule for holes.  
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3. Use Save to file  to toggle between drawing the schedule on 

the diagram and saving to a file using the Save As dialog. 

4. Click OK to accept the changes and close the dialog. 

Ejector schedule 

1. Create a drawing of the model. 

 

2. Click  to produce a schedule for ejector pins, core pins and 

return pins. 

 

3. Use Save to file  to toggle between drawing the schedule on 

the diagram and saving to a file using the Save As dialog. 

4. Click OK to accept the changes and close the dialog. 
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